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How to Use This Book

Who This Book Is For

This book is for the reader who has never used this
particular technology or software application. It is also
for readers who want to expand their knowledge.

The Conventions in This Book

o Steps

This book uses a step-by-step format to guide you easily
through each task. Numbered steps are actions you must
do; bulleted steps clarify a point, step, or optional
feature; and indented steps give you the result.

e Notes

Notes give additional information — special conditions
that may occur during an operation, a situation that you
want to avoid, or a cross reference to a related area of
the book.

Swap
Pictures

You can add pictures to your publication — pictures  area;
stored on your hard drive or pictures you download can swap 3

ide the publication page. Then, you
e in your publication for a picture
from the Internet — as described in Chapter 3. But in the scratch area. You can continue substituting
you might not know what photo you want at a different pictures until you find the right one for
particular spot in your publication. your publication.

Publisher's Swap Pictures feature enables you to

insert several pictures simultaneously into the scratch

Swap Pictures

Note: This section assumes that you
already have inserted one picture, as
described in Chapter 3.

&o Click the Insert tab.
@ Click Pictures. [ ]
The Insert Picture dialog box appears. K - —

o Navigate to and select the pictures
you want to consider.

You can select multiple pictures by

holding (1 as yo k each one.
O Click Insert-

© The pictures appear in the scratch area

outside your publication page.
&Note: Publisher surrounds each picture
with selection handles (T and [}

to indicate they are all selected.

e Click anywhere in the scratch area
outside the pictures so that none is
selected.

@ Click a picture you want to place on -
the publication page. E
© A button containing an image of a
mountain () appears in the center @
of the selected picture.

e Icons and Buttons

Icons and buttons show you exactly what you need to
click to perform a step.

0 Simplify It
These tips offer additional information, including
warnings and shortcuts.

e Bold

Bold type shows command names, options, and text or
numbers you must type.

O Italics

Italic type introduces and defines a new term.

CHAPTER
PUBLISHER

Publisher Basics

B e - ¥ @ Drag . to place the picture

: . & mE o - from the scratch area on top of
" e I the image that is already on the
publication page.

-0 @ The picture disappears from the
scratch area as you drag it to the
publication page.

= - —r— _ LE 2] Rel_ease the_ mouse button when
: TN P - a pink outline appears.

© Publisher swaps the original
picture for the new one.

it

To swap pictures, do they have to be in the scratch area?

No. You can swap two pictures on a publication page. Just follow the steps in
this section, dragging . on one picture on top of the other picture. The two
pictures exchange places on the page. The scratch area is useful when you
want to choose between multiple pictures for a page or when you want to add
pictures to several pages. The pictures can temporarily reside in the scratch
area while you make your decisions. When you no longer need a picture in the
scratch area, click it to select it and then press (0.
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B putosave (@  Enter password [E] oK Hever for This Site. £

Elaine Marmel
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difference today.
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Chapter 1: Office BasiCs « oo cvvvevenerececocnsncsonncnns 4

Chapter 2: Workingwith Files . . . ... .. ii it iiiiiiiiennens 18

Chapter 3: Office GraphicsTools .......coiveeieieeeennns 34

Chapter 4: Working with Office Files Online................. 42



Start and Exit

Office Applications

Office 2016 runs on a 1-gigahertz (GHz) or faster This section uses Access to demonstrate how to open
x86- or x64-bit processor with 1 or 2 gigabytes a program from Windows 10. Once an Office program
of RAM, based on your processor speed. Your opens, its Start screen appears, helping you to find a
system must be running Windows 7, Windows 8, document you recently worked on or to start a new
Windows 10, Windows Server 2008 R2, or Windows document. For other ways to open or start a new
Server 2012. document, see Chapter 2.

Start and Exit Office Applications |
@ Click in the search box.

() The message box introducing
Cortana appears.

Note: Cortana is the Windows 10 | Ferneetatingd
search assistant. Click Learn
more to read about Cortana.

e

I can remind you to do something at a
particular time, place, or both.

il Kearch the web and Windows
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@ sStart typing the name of the
program; for this example, type
Access.

@ Access 2016 Preview
Desktop app

Settings

8 Other Ease of Access settings

© A list of choices appears that

B Ease of Access mouse settings

B Work olders match the letters you typed.
81 Ease of Access keyboard settings " . . .

€3 Sync your Ease of Access settings 9 Cl]Ck the Ch01ce match.lng the
8 Choose an account for assigned access program you Want to Open.

Folders
Access Stuff

Store

B ATST Alacess - The program opens and displays
B et Open Acces i its Start screen, which helps you
, open new or existing documents;
see Chapter 2 for other ways to
open documents.

52 My stuff £ Web 5 10F v .

. ﬁﬁ - . @ You can use this panel to open
" an existing document.

Access e ““’““““’.iﬁffffé @ You can use this area to start a

Recent new document.

*% @ This area indicates whether you
(@@ Open Other Files

have signed in to your Office
365 subscription.

Note: See Chapter 4 for details
about signing in to Office 365.

Blank deskiop database

the Close button ().

Note: If you do not see the Close
button (), slide the mouse ([})

m into the upper right corner of the
P - screen until it appears.

@ To exit from the program, click
6 ©
&b

Can | create a shortcut to open an Office application?

You can, but pinning the program to the Windows taskbar or Start
menu is easier. Follow Steps 1 and 2 in this section. Then, right- Folders
click the program name in the list. From the menu that appears,
click Pin to taskbar or Pin to Start. Windows 10 pins the program
to the Windows taskbar or the Start menu. To open the program,

@ Access 2016 Preview

Run as administrator

. Ad Open file location

Settingd  Unpin from Start

click the program’s button on the taskbar or Start menu. Programs =M pin to taskbar
pinned to the Start menu appear on the right side of the menu Ll I
as tiles. & of




Navigate the

Program Windows

All Office programs share a common appearance and a Quick Access Toolbar (QAT). The Ribbon
and many of the same features, and when you learn  contains commands that Microsoft Office determines
your way around one Office program, you can easily that you use most often, and the QAT contains

use the same skills to navigate the others. These frequently used commands; you can customize both
common features include scroll bars, a Ribbon, elements.
O Title Bar O Quick Access @ Ribbon O Program
Displays the name of ~ Toolbar Displays groups of Window
the open file and the  Displays quick-access related commands in Controls
Office program. buttons to commonly tabs. Each tab offers These buttons enable
used commands such as  buttons for performing you to control the
Save, Undo, and Redo. common tasks. appearance of the

program window. You

% L] (4] s &Documenﬂ-Wurd (THaly can m-in-im-ize the
Home  Inset  Design  Llayout  References Mailings  Review  Miew @ Tell mewhatyouwant to do.. & .
T LT R =R =R PR o Ribbon, and you can
& . tDE@ . S, - 2aBhCoDr| aaBbCrDe AgBbCL AaBbCe F . Replace minimize, maximize,
rPaste. & BT U-axx, ¥ A-F-A-=E=== |=- - U Thormal | Tho Spac.. Heading1  Heading2 | ecte
- b sl restore, or close the
Clipboard & Font [ Paragraph n Styles & Editing ~

program window.

@ Office 365
Indicator

If you see your name,
you are signed in to
your Office 365
subscription. You can
click your name to
display a menu that
enables you to
manage your
Microsoft account
settings or switch to
a different Microsoft
account. If you are
not signed in, this
area shows a Sign in
link. See Chapter 4

& e I . m—_ L]

@ Status Bar @ View Shortcuts ) Zoom Controls for details about
. . . . . signing in to Office
Displays information  These shortcuts switch  This feature changes the il
about the current to a different view of magnification of a
Office document. your document. document.



Work with

Backstage View

You can click the File tab to display Backstage view.
In Backstage view, you find a list of actions that you
can use to open, save, print, remove sensitive

information, and distribute documents as well as set

Work with Backstage View

Word program behavior options. You can also use
Backstage to manage the places on your computer
hard drive or in your network that you use to store
documents, and to manage your Office 365 account.

Document1 - Word {Trial)

Inset  Design Layout  References  Mailings

d © (]
Harne

% Calibri (Bocy) - |11 - A A Aa- A

Paste

o E=a=

o B I U-vakx, X A-¥-p-

P
il

clipboard Font & Paragraph

Review

Miew Q Tell e whatyou want to do..

@ Click the File tab to display

signin PSRN

s
B asBioceDc | asBbCede AEBOCC ABbCCL —

- | 1 Nommal

THo Spac...

Styles

Heading 1 Heating? <) o

P Find -

Backstage view.

3 Replace

o Editing ~

Open

® Recent
[

E

OneDrive

{3 msee =

+

i i)

Add a Place =

Browse

ﬁpn

E

6 Yesterday

Ward (Trial)

Today i

For Immediate Publication.docx
Dacurments » Office 2016 Data = Word Stuff
2016-Author Bio-AZ.docx
Dacurments » Office 2016 Data = Word Shaff
2016-Author Bio-FL.doox
Dacuments » Office 2016 Daty = Ward Stuff
201 6-Gettysburg Address-First.doo
Docurments » Office 2016 Data = Word Stuff
table format.docs

Dacuments » Office 2016 Dats = Word Stuff
table.docx

Docurments » Office 2016 Data » Word Stuff

table-shading.docx

Documents » Office 2016 Data = Word Stuff
table-merge cells doox

Daocurnents » Office 2016 Dats » WWord Suff
table-before formatdocx

Dacurments » Office 2016 Data » Word Shuff

table firstdocx

Documents » Offics 2016 Date » Word Stuff

George Washington's First Inaugural Addr..
Docurments » Office 2016 Data » Word Shuff

2016-Gettysburg Address-Plain.docx
Dacurments » Office 2016 Date = Word Suff

@ Commonly used file and program
management commands appear
here.

© Buttons you can click appear here.

@ Information related to the button
you click appears here. Each time
you click a button, the information
shown to the right changes.

7/9/2015 T:42 A

7/9/2015 1:51 &M

7/9/2015 1:50 A

7/9/2015 1:10 AM

F//2015 1110 AM

7972015 1:08 &M

Note: The New, Close, and Options
commands do not display buttons
or information, but take other
actions.

© Click the Back button (@) to
: return to the open document.

T/82015 344 AW

7/8/2015 8:47 A

TB/2005 243 AM

772015 943 A0

F/B/2015 8:26 AM

T/8/2015 823 A0




Change the

Color Scheme

You can use Office themes and background patterns
to change the appearance of the program screen.
Themes control the color scheme the program uses,
and background patterns can add interest to the
screen while you work. Color schemes can improve
your ability to clearly see the screen, but be aware
that background patterns might be distracting.

Change the Color Scheme

Office themes are available even if you are not
signed in to Office 365, but to use background
patterns, you must sign in to Office 365. For details
on how to sign in and out of Office 365, see
Chapter 4.

Note: Make sure you are signed

=}
I:

in to OﬁClce 365. See Chapter 4 i : Cafbr Bo2) - {1 (& Rl 2| 8| 9 | [scbee] astheax AaBbcc aaBocer - ':;:::m

for deta,[S. Paste 0| B I W-akx ' |R-¥-A- o R} Toimal | Tho Spac. Heading 1 Heading2 = |y g,
@ Click File to open Backstage |

view.

|
Page of1 Ab1™ Lineil Column1 Owords mmsert £ B el 5 - 1 + mm:

o Click Account. Docurmant] - Word (e 7 - =& ) x“
@ Click the Office Theme . Account

@ Click an Office theme.

User Information Product Information

] Office

Elaine Marmel

e Dgmail.com

Change phota

Aout e
Sign out % Trial Product
Switch Account Micrasoft Office Professional 2016
c"":j;‘ 1| This product contains
Office Background: DO REEE
HNo Background #] The trial period will expire in 130 days. You can purchase
L. the full version of this product or remave it fram this
computer,
5 - =
’ 3 Ky Office Updates
e 4 B Updates are automatically downloaded and installed.
Update | yersion: 16.04228,1006
White Options
g @gmail.com 3
Adda service e About Word
Learn mare aboutVord, Suppart, Product 10, 2nd Copyright
Abaut information.
Word
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The colors of your program change.

Account A Note: Some theme changes are
’ _ : more subtle than others.
ser Information Product Information

- E‘”‘ ﬂ Office © Click the Office Background .

g oot Q Point the mouse ([}) at a choice in

Convert to

Office Background: the menu tO highljght that ChOice.

No Background

O A background pattern appears at
the top of the window. The pattern
remains as you work on documents.

Office Updates
nal Dl

0 Click the pattern you want to use
or click No Background.

@ Click the Back button () to
return to your document.

A The Office theme and background
ol eoEEme T . \ = you selected appear.

25 Replace
B I U-acx x B-%-A - - J | By selece-

o 2 anng © The background appears in the title
bar and the tabs of the Ribbon.

Un derwater

Font.

Pageiefl At1T Line:1  Column

W5 B -———+ s

o pum What happens if | select an Office background and then sign out of
Office 365?
The background no longer appears in the program, but will reappear when you
next sign in to Office 365. Similarly, theme changes you make while signed in
to Office 365 might disappear when you sign out of Office 365. With themes,

however, you do not need to be signed in to Office 365 to make a selection.
Just complete Steps 1 to 4.



Find a Ribbon

Command

When you need to take an action that you do not You can still use the Ribbon directly, as described in
take on a regular basis, you can make use of Office the next section, “Work with the Ribbon.” The Tell
2016’s new feature, the Tell Me What You Want To Do Me What You Want To Do search feature is most
feature. The Tell Me What You Want To Do search useful when you are not sure where on the Ribbon to
feature helps you find commands on the Ribbon. find the command you need.

Find a Ribbon Command

o Open a document in an Office
program.

Note: See Chapter 2 for details
on opening an Office document.

© Click here.

O A list of commonly requested
actions appears.
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B = (<4 =} = 3 mionth salessds - Bxcel (Trial) x
Home  Insett  Pagelayout  Formulas  Data  Review  View @ Tell mewhatyouwant o do ﬂ @
‘-:] kS u A a ==Ee- = ’Gmm'—v‘ B Conditional Formatting - 5 Insert ~ 3+ %Y p
- 57 Format as Table - BrDelete ~ [T~ [
Paste Blru- 2 b-A- === S W b A8 Fin
¢ Blru- @ £ E- $-% o020 T el Styles - Eifamats &~ oo seieat-
Clipboard = Font 5 arignment B Humber n Stfes cells Editing ~
A1 - fe | 3Month Sales Figures for 2016 v
| A 5 c ] EF G H bk L M [=]
1 [3 Month Sales F\'guFFs for2016
2 {In Thousands)
3 January  February March
4 |widgets 140 135 145
5 Gadgets 149 163 173
6 Sedgets 165 189 203
7 Total Sales
8
]
0

1
iH
12
“
15
6
7
.
19

B ©- B = 2 manth sales.dsx - Excel (Trial) [ - a x
Heme  Insert  Pagelayout  Formulas  Dats e Q) Signin [PSREEN &

Review g

= . =, R tly Used - -
%% [Chitge [ oA & 4 S e - 2 2
U gy - © Move or Copy Sheet ExDelete - [~

Paste Lm. M.a B. §- - Sort & Find &
e BlTu- - 0-a $ 7% ] et Fom Elfomite @ e s e

Clipboard = Font & Alignment A Humbe Try Cells Editing ~

et it
Al - £ || 3Month sales Figures for 2016 s e M
insert atable

B c [*] E F

A
1 |3 Month Sales F\‘gupps for 2016

K L M M=

Freeze the top row L =

z {In Thousands)

E] January y February March
4 |widgets 140 135 135
5 Gadgets 149 163 173
6 Sedgets 165 189 208
7 Total Sales

8

a
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1
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15

16

7

18
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20
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2 manth salesxdss - Excel (Tral) ® - 8 %

H = s =8
Home  Insert Review, ew  Q char ﬂ
) T Insert Colun WOPEa; Chart

*

Page layout  Formulas Data EILE ©. share [ESY

» | 2D Column

Coliorilight  -[14 | A &
BB - Text Function f
Paste « . - - - -
y Bru-E- 5-4 $ 7% | 5 Recommended Charts Hﬂ'\ PP |:|q
Ciipboard & Font be ST Insert S r Chart D Column ~
3
a1 - % | 3Manth Sales Figures for 2015 lly tnsert 5 L v
£ smartLooku; 3 ﬂlﬁ q ‘TJ%
A 8 c ) 3 P U A B[~
Get Help on “char .
1|3 Month Sales F\gur_las for2016 L 2-D Bar
2 {In Thousands) =
3 January February March E=
4 Widgets 140 135 145 o
5 Gadgets 149 163 173
6 |Sedgets 165 189 203 = B =
7 Total Sales [Sl====]

Itd More Column Charts..

3 month sales.xlsx - Excel (Trial) Chart Tools = - 2 x

Pagelayout  Formulss  Dats  Review  View  Design  Format @ Tell mewhatyounanttodo..  Signin [FeRie

= ol
= |- SwitchRow/ Select  Change
Column  Data  Chart Type

Data Wpe  Logation -

H ®-c¢- Q&
Home Insert.
.

|

iy @

AddChert Quick  Change | —

Element = Leyout = Colars *
Chart Layouts

Chart 1 - fe .

A 8 c o E F G H ) K L M n
1 |3 Month Sales Figurles for 2016
2 {In Thousands)
3 Januar, y_Fel
4 [widgets
5 Gadgets
6 Sedgets
7 Total sales

] #
&

? 00 S
0

1 150

2 100

2 -

“

Widgets

Gadgets Sedgms

ChartTitle

Toral Sales
7 3 Month Sales Figures for 2016 (In Thousands) Januzy

% 35 Month Sales Flgure:

In Thousands) Fenruary

19 5 Month Sale Figur es for 2016 (In Thousands) e ch

Will | need to type a description of the action
I want to take if it is the same action | have

previously taken?

No. The Tell Me What You Want To Do search box
remembers your previous searches and displays
them on the menu that appears when you
perform Step 2.
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e Type a brief description of the
action you want to take.

© The program lists possible
commands you can use to
complete your task.

@ Click a command to use it.

@ Commands with arrows (»)
display additional commands.

(@) The program performs the action
you selected; in this example,
Excel charts the worksheet data.

If I no longer want my previous
searches to appear, can | clear them
from the list?

No. The Tell Me What You Want To Do
feature retains your searches in the
Recently Used section of the menu that
appears when you click in the search box.

11



Work with

the Ribbon

In addition to letting an Office program help you In all Office programs, you can customize the Ribbon
find a command, you can select commands using the  to support the way you work. For example, you can
Ribbon. Each Ribbon tab contains groups of related create your own Ribbon tab that contains the
command buttons. Each button performs a common buttons you use most often; that way, you can avoid
task. Some tabs appear only when needed. For switching tabs to use a particular command.
example, if you select a table, the Ribbon displays

the Table Tools tab.

Work with the Ribbon

Using the Ribbon Hoo oo @ - a
Home Insert Page Layout Data Review Wigwy Q Tell me what you want to do.. Share
@ Click the tab containing the command |21 52 1 oy e s "5 i B o0 T I T

Th!{"“@[fﬁrﬁ' M“.gm o . = :,::t, et B TP.:(: B scale: 100 - [ mrint | Efj Selection Pane A Rotate
you want to use. = HTy e B A .
al Left: or Right: 0.7:‘ -
@ Click the command. = . e w o w o g
(@ Buttons with arrows (w) display : Wt BL
additional commands. : [] & & e

© You can click the dialog box o
launcher (%) to display a dialog 2
box of additional settings. :

Create a Ribbon Tab .
@ Click the File tab. “

@ Click Options to display the Options
dialog box.

@ Click Customize Ribbon. —

Generel E-E Customize the Ribbon,

. F |
Click the tab you want to appear to P S
resting [Popular Comrmands [Main Tabs
the left of the new tab.
Language £dd or Rernawe Filters " [Main Tabs
W0 Al Chart Types.. =l [ New Tab (Custom)
o P! d Bord, 3
© Click New Tab. e e B
Custamize Ribbon P -
W d t t b d Quick Access Taolbar o S Renarme S :nt
ignnent
o ord creates a new tab and a new s ¢ sy mme: S I I
!

Styles

y B Cells

B ol Editing
Delete Sheet Columns ® & Insert

x IE]e\et‘eSheetRnws # [ Page Layout
mall —
® & Farmulss

Fant Calor r [ Review
Font Size I=| A Views
;“”"f:e"‘t # [ Developer
armat Painter

EE] Freeze Panes » E4Add-ins

group on that tab. To reposition the
tab, click it and click the arrows.

@ Click New Tab (Custom).

@ Click Rename to display the Rename
dialog box.

\" Increase Font Size & [ Background Removal
E= InsertCells
Insert Function,.,
Isert Picture

" Insert Sheet Columns

\

- NewTeb | | Hewtroup | | Renarme.. -

Insert Sheet Rowes

B Insert Table Customizations: | Reset = [@
Macros -
=] Merge & Center Irport/Export v |@

0K Cancel

e Type a name for your tab and click OK.

© Click New Group (Custom) and repeat
Steps 7 and 8 to rename the group.
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Add-Ins

Trust Certer

Excel Options ? %
General ]
snere E-E Customize the Ribbon.
Formulas
Choose commands from: @ Custornize the Ribbon:©
Procfing [Popular Comrmands D [Msin Tabs
Save
Add or Remawe Filters ~ [Main Tabs ~
L
anguage Wl Al Char Types... E & Elaine’s Tab (Custom)
Advanced Borders [» B Mew Group (Custarn)
- Calculate Now €= Insert Sheet Fows
Custarnize Ribbon Center SX Delete Sheet Rows
= V itu
itk fecess Toolbar F Szzjwtmna\ Formatting — Insert Sheet Calumns
g ome

Custom Sort Clipboard
f cut Fant
Decrease Font Size Alignment

Delete Cel Mumber
Delete olurmns ) Sryles
j Cells
.
Ernail 3 Fl Editing El
Fil Color [ b S -]
Font L=

Font Calor [ EAPage Layour

Fant Size = M Formulas

Format Cells & A Data
Forrmat Painter [ Review

[ Freeze Panes v © Fview

|A Increase Font Size ® [ Develaper
Eo nsert Cells

Insert Function... [ [ Add-Ins v
o Insert Picture < >
il
T Insert Sheet Columns New Tab | ‘ Mo Group ‘ ‘ F—

Insert Sheet Rowws

BT Insert Table Custarizations:
Matros
= Import/Export v |©

()]

= Merge & Center
0K Cancel

S X Delete Sheet Rows

n

i B BN H B & = BookT - Excel (Triah m - 8 %
Efsine’s Tab et Pagelamjout  Formulas  Dats  Review  View @ Tellmewnstyouwantto do sign i share [T
s

= B Insert Sheet Coluran:

sert ,
Sheet Rows X Delete Sheet Columns

Swve | Calibri - abe Srikethrough A% Sort & Filker - X b =
9 z f =
s s 11 - ¥ Format Painter Daste Bcopy | J = =
Open Find & Wiap Merge &
RecentFile 159 Open £ - ElFormatCells  gajeer € Undo & Clear~ | General - Tedt  Centere =
File Font Editing lumber Alignment ~
£ M
D E F G H ) K L M N o

How do | assign keyboard shortcuts to the
buttons | add to my group?

Each Office program assigns keyboard shortcuts for
you, based on the keys already assigned to commands
appearing on the tab where you placed your group.
You can place the same button on two different tabs,
and if you do, the program assigns different keyboard
shortcuts to that button on each tab.
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Add Buttons

@ Click the group on the tab you
created.

@ Click a command.

© If the command you want does
not appear in the list, you can
click the Choose commands
from 'v] and select All
Commands.

© Click Add.

@ The command appears below the
group you created.

Q Repeat Steps 2 and 3 for each
button you want to add to the

group.
© Click OK.

@ The new tab appears on the
Ribbon. If you positioned your
tab as the first tab, it will
appear each time you open the
program.

What can | do if | decide that |

do not want a custom tab on the
Ribbon?

Reopen the program’s Options dialog
box and deselect the check box beside

the tab you created ((v| changes to | ).
Click OK.

13



Customize the Quick

Access Toolbar

The Quick Access Toolbar, or QAT, is located in the
top left corner of the program window above the File
and Home tabs. It offers quick access to the
frequently used Save, Undo, and Redo commands. If
you want, you can customize this toolbar to include
other commands you use often, such as the Quick
Print, Print Preview, or any other command.

Customize the Quick Access Toolbar

You can also reposition the QAT so that it appears

below the Ribbon rather than above it; and, if you

change your mind, you can put the QAT back above
the Ribbon.

@ Click the More button ().

@ You can click any of the common B
commands to add them to the
toolbar.

© You can click Show below the
Ribbon if you want to display
the toolbar below the Ribbon.

Q Click More Commands.

=]
In Customize Quick Acce:

55 Taol Review  View Signin &
New %: =x=-|1| As ',\:—:l [ E %) Bring Foraard P Find -
Open & B 2 5end ard vp 35 Replace

Ul sme § WS D e | w2 Mg [t Select =
Quick Print Farsgraph syes  opes nge cating A
Riint Breiew Bt Bu B BBt BB BB BB B
Speling

9 v Und

Publication? - Publisher (Trialy 2 - a x

Ll
ahondndendd ol

The Options dialog box appears. e
. Genersl = cCustomize the Quick Access Toelbar,
@ Click the Choose commands @9
Save =
from E' Language :ﬂpz:rﬂnmmahds AQ Custamize Quick Arcess Taalban®
Advanced Cornmands Not in the Ribbon B seve
Click a command group. A Commoncs B s
(4]

Add-Ins

Trust Certer

Home Tab

Insert Tab

Page Design Tab

Mailings Tab

Rewizw Tab

Adc-ns Tab [-]
View Tab El
Web Tabs

Developer Tab
Catalag Tools | Farmat Tab
Drawing Taols | Format Tab
Text Box Tools | Format Tab
Word#t Tools | Format Tab

Picture Tools | Format Tab
Table Tools | Design Tab

Modify..

Table Tools | Layaut Tab v
[ Show Quick Access Toalbar below the et miztiens
Ribbon

Import/Expart ¥ [

aK Cancel
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Publisher Options ?

General . .

E-E Customize the Quick Access Toolkar,
Proofing

Choose commands from:(:
S File Tab <
Language Custorize Quick Access Toolbar(
Advanced <Separators “ B save

F Close File 0 € Undo »
Custamize Ribban L Design Checker. @ Redo

[&] Edit Business Information..,
B0 E-mail as PDF Attachrment

»
* CloseFile 0

Quick Access Toolbar

Add-Ins @3 E-rail 23 3PS Attachment
& i
st Conter 8 Email Preview

X Exit

[0 Mail Recipient (as Attachment)

[0 Mew from Template

Open

Preview and Print »
Print

Print Preview

Publish as PDF or 3PS

Publisher Options

Quick Print

Save

Saue A5

Send v
Send Publication as PDF Attach...

U3 Send Publication a: XPS Attach...

[ Send to Mail Recipient

FER, Send to Mail Recipient. v

Add >>0 -

<< Remove

s Akalan [ Jurlirlaal i

Customizations: | Reset v

[ Show Quick Access Toalbar below the

Ribbon Import/Export = |0

<

Cancel
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© Click the command that you
want to add to the toolbar.

@ Click Add.
@ Office adds the command.

You can repeat Steps 3 to 6 to
move additional buttons to the
toolbar.

@ Click OK.

Review  View

maE Page Design  Malings
Past o B I WX M- A =-

aragrap

4 (a5 B8
14 B B
Styles  Draw  _ Wip
TextBox &7 e [

Obiects

How do | remove a button from the
Quick Access Toolbar?

To remove a command, reopen the program’s
Options dialog box by following the steps in
this section, click the command name in the
list on the right, click the Remove button,
and click OK. The button no longer appears
on the toolbar.

Dublication - Publizher (Tiisly 2 -

Font P aph Sty Arrange
bt P b Bl Bt Bt R Bt Bt BBt BB Bt B

diting

el Bl e

© The new command appears on
the Quick Access Toolbar.

S

Are there other ways to customize the
Quick Access Toolbar?

Yes. You can add commands to the toolbar
directly from the Ribbon. Simply click the tab
containing the command that you want to add,
right-click the command, and then click Add to
Quick Access Toolbar. The command appears
immediately as a button on the toolbar.
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Using an Office Program

on a Tablet PC

Using Office 2016 on a tablet offers a different
experience than using the programs on a computer
with a keyboard and mouse. This section shows you
how to open an Office program on a touch device
and how to switch between Touch and Mouse modes.

Office enhancements for tablets are limited primarily
to enlarging buttons on the Quick Access Toolbar and

the Ribbon to make selecting commands easier. For a
friendlier touch experience, consider using universal
Office apps for various mobile devices, which,
although not as powerful as Office 2016, were
written specifically for touch devices. You can share
documents across platforms.

Using an Office Program on aTablet PC _
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